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InspectNOW PocketPC User’s Guide 
 

 

 

Introduction 

 
This guide was created to help InspectNOW PocketPC users create an inspection and 
capture critical inspection data in a fast and efficient manner.  The primary function of 
InspectNOW PocketPC is to make data collection and report generation easy for the 
professional inspector.  Using this advanced technology not only frees up the inspector to 
spend more time examining the critical systems of the home, it’s sure to impress the 
clients.    
 
This guide explains the various features, functions and benefits of InspectNOW PocketPC.  
It also walks you through creating an inspection and gathering the inspection data one step 
at a time. 
 
The pages that follow include a table of contents, step-by-step instructions on how to use 
the InspectNOW PocketPC system, and a definition of common terms for your 
convenience. 
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Setting Up Your PocketPC  
This guide assumes that you have already loaded InspectNOW PocketPC on your handheld 
device.  See Software Installation instructions for directions. 
 

Inspection Walk-through 

Setting up a new inspection in a PocketPC 

To Launch InspectNOW, turn on your PocketPC. From the Desktop, single-tap the window icon 
to the left of Start at the top of your screen.  This will open a menu, pick Programs , pick 
InspectNOW from the list of programs.  (Note: you can set your PocketPC to show InspectNOW 
automatically in the Start menu through the Settings options) 
  

                                                         
 
Unlike traditional PC’s, PocketPC menus appear at the bottom of the screen.  To create a new 
inspection document select File , select New and 1 of 2 blank Inspection Setup screens will appear.  
Use the pen or keyboard to enter general information about the inspection such as Dwelling 
Address, Realtor, Agency, Client Name, etc.  (Note – to enter data into a specific field, tap once on the 
field to place the cursor in that field, then type or write the information you wish to store in that field) 
 

  

Tap  here 
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Notice that some fields have a button with a black triangle at the far right.  This triangle 
indicates a popup list (also referred to as pick lists) associated with the field for quick 
entry of common data.  You can add your own items to these pick lists.  To maintain a 
pick list, tap the triangle to bring up the list, then tap Edit List.   
 
A dialog will appear showing the items currently in the pick list.  Use the buttons in this dialog to 
add new items or to delete or edit existing items.  To add an item, simply tap the Add button, enter 
the text for the new item and click OK to see the new item in the list. Click OK once more to 
return to the Inspection Setup screen. 

Now you can tap the triangle to bring up the list with the new item in it.  Tap on the item you want 
and it automatically goes into the field.  (Note – if you bring up a pick list and do not want to 
choose any of the items, simply tap away from the list to make it disappear.) 

The most important item to complete on the Inspection Setup Screen is the Document Type  field.  
Other fields may be left blank but you must pick a Document Type from the pick list so that 
InspectNOW knows which category, step, and comment templates to use for the inspection.  
InspectNOW comes with two basic templates 1) Matrix Deluxe and 2) Property Inspection.  It 
initially defaults to the Matrix Deluxe template. 

Complete the remaining fields.  Doc # can contain both letters and numbers and should be unique.  
If you have created an inspection record in InspectNOW Office you should use the exact same 
Doc #.  The document number appears in the upper right corner of each report page, it serves as 
the unique identifier from one printed report to the next.  Examples of unique document numbers 
are a combination of client name and date (Client Bill Smith inspection on 2/15/07 Doc # 
SM21507) or date and inspection number (Second inspection performed on Feb 15, 2007 Doc # 
21507-2).  Pick a numbering convention that assists you in filing and tracking of reports.   

Inspection Data Overview 

To enter the actual inspection data, you first must view a list of categories available for the current 
inspection.  To do this, tap the View menu and select Category List. 
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Notice how the Category List has two columns.  The first column displays the category name.  
The second column shows the status of the category.  By default, all categories in a new inspection 
have a status of  “Incomplete”.  When a rating has been entered for each step within a category, 
the status field for that category will change to “Complete”.  
 
There are 3 buttons on the bottom of the Category window see above.  
 
Not Present – The "Not Present" button is used when you want to flag a Category as not being 
present on this inspection.  You select the Category by tapping on it’s associated radio button 
(small circle to left of category name) and after it is highlighted you tap the "Not Present" button 
and the status of the Category changes from "Incomplete" to "Not Present".  This is not 
recommended if you are printing the Matrix Deluxe style report. 
 
Renaming a category on the fly – The second button, the "Rename…" button, lets you change 
the name of any selected Category for the current inspection.  This is only for the current 
inspection and does not change the template data in any way.  All the original Category's Steps, 
Materials, Ratings, and Step Info stay intact.  The only thing different is the actual name of the 
Category.  A good example would be to have a "Bathroom" Category you can rename to "Master 
Bathroom" or "1st Floor Bathroom".  First tap on the circle to the left of Category you want to 
rename causing the circle to darken.  Next tap the Rename button. Tap the black triangle and pick 
from the options provided or use the keyboard or transcriber to insert a new name.  
 

       
 



InspectNOW PocketPC User’s Guide  6 of 25 

Duplicating a category on the fly – InspectNOW has a powerful feature that allows you to 
duplicate a Category on the fly.  In other words, if you are inspecting a property that has a second 
Garage, you can use the Garage Category as a template to create a second Garage Category with 
all of the same Steps, and Comments from which to choose.  The Step numbers are the same 
except an additional number is appended to the end of each Step number.  As an example the Step 
"62 Vehicle Door" in the original "Garage” Category would be "62.2. Vehicle Door" in the newly 
duplicated "Garage” Category.  The process is the same as renaming described above.  First tap 
the circle to the left of the category name you want to duplicate, then click Duplicate .   
 

    
 
You can also change the number of duplicates you want created by changing the value in the 
“How Many:” field which defaults to one.  The name of the new Category does not have to stay 
as the default (like "Garage #2") but can be changed to anything you feel is appropriate.   

Step List Window  

Single-tap a category to view its corresponding step list window.  In the example below single -tap 
Grounds  and the step list window for Grounds  appears.  Double-tap Sidewalks and the 
Sidewalks step detail window appears. 

        
 

Category Window Step List Window Step Detail Window 
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The Step List window has a list of all the Steps/Components for the Category you chose.  The 
window consists of 2 columns of data:   
 

Step Name  – a list of the steps or components that make up the Category.  In the case 
above, Driveway, Sidewalks, Retaining Walls, Patio, Patio Cover, Decks/Porch and Fence 
& Gates are the components of the Grounds Category.  As such each of these components 
will appear on the Grounds page of the inspection report. 

 
Rating – the rating (Appears Serviceable, Repairs Recommended, Safety Hazard or N/A – 
not applicable) can be chosen for each step by clicking on the black triangle and picking 
from the corresponding pick list.  Ratings can also be chosen one step down at the Step 
Detail Window. 

 
The Step List window has three unique buttons across the bottom. 
 

To Categories – selecting this button will return you to the list of Categories for your 
current inspection.  You can do your inspection in any order you want and jump between 
Categories be returning to the Category List and selecting another Category.  This makes 
data collection easy as you encounter the different systems of the home during the logical 
path of the inspection. 

 
Duplicate… – this feature is similar to duplication of a Category explained above.  This is 
very useful when the property has multiple components.  Example – Fireplace(s) are 
located in the Interior-2 tab.  If the home has more then one fireplace, simply duplicate the 
fireplace step and identify the applicable location. This new Step is inserted right after the 
original Step in the list.  When this Step is duplicated the new Step will add a letter to it's 
Step number so it would become "52a.Fireplace" and it will have the same rating choices, 
materials and comments available to it as the original Step.  You can also rename this new 
Step to whatever you want when duplicating it.  Again, just like duplicating a Category 
this new Step is only for the current inspection and does not change your Template Data. 

 
Defaults– In order to make the rating process efficient when few defects are observed for 
a given category, InspectNOW has an advanced feature that allows you to apply rating 
and material defaults.  The standard Matrix Deluxe and Property Inspection templates do 
not have any preset defaults.  You can set the default rating and default materials to be 
applied for any given step through Template Maker. (Refer to the Template Maker User’s 
Guide for details.)  Once defaults are identified in Template Maker and the data file 
copied to the PocketPC, just tap the “Apply Defaults” button and all of the unrated steps 
will receive a default rating and any default materials will get checked.  Any Step that has 
a Rating that has no default rating choice will remain blank.  It’s important to remember to 
change a pick of the default setting is not appropr iate for the specific property inspection.  
Using defaults properly can save the user data entry time, however this is generally 
considered a function for advanced users. 
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The Step Detail Window is where the bulk of the inspection data is placed into the data file.  This 
screen contains four tabs, the rating pick list window, “forward/backward” buttons and the multi-
picker button.   

Rating – the inspector uses a drop down or pick list to choose the appropriate rating from 
the rating window.  Ratings options include: 

Appears Serviceable  (defined in the inspection key) 
Repairs Recommended 
Safety Hazard 
Not Applicable  

Material – materials appear as a series of check boxes that identify a variety of items such 
as:  

Type of building material such as Stucco 
Location such as Patio 
Common Conditions such as Major Cracks, Exposed Wiring, etc. 

 
Comments – used to provide additional comments about the condition of the step.  
Comments can be picked from a categorized comment library (pick list) for placement in 
the inspection report or they can be input on at the time of inspection.  Comments input at 
the time of inspection can be added to the comment library for future use or used in that 
specific report only.  This section of the report expands to accommodate the amount of 
comments, there are no space limitations. 
 
Pictures – pictures can be added to the report.  InspectNOW’s unique picture 
management program tags the picture for easy reference. 
 
CC / Info – Code Check 4th edition references are built into InspectNOW.  This makes it 
easy to look up critical references during the inspection.  In addition to the preloaded 
references the inspector can add additional reference materials for easy access.  Now you 
can have a reference library in your hand throughout the inspection. 

 

   

Step Detail Window 

Materials, Comments, Pictures, CC / Info tabs 

Ratings Pick List Window 

Directional Buttons 
<< Backwards to prior step 
   >> Forwards to next step 

Multi-picker places all materials on a scrollable window for easy access 
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Entering Inspection Data 

The process of entering inspection data is organized by category.  For every category there are a 
number of steps and for each step there is a step detail window where the bulk of the inspection 
data is entered. The Matrix Deluxe and Property Inspection templates that come with InspectNOW 
have established Categories, Steps, Material / Conditions, a robust Comment Library and Code 
Check® 4th editions references where applicable.  Additional references can be added by using 
Template Maker (see Template Maker User’s Guide for more information). 

Below is an example of the processes used to enter data and produce an inspection report.  This 
example will focus on the Exterior category, Exterior Walls step.  The inspector can repeat these 
basic processes for the various categories and steps throughout the inspection.  Data collection is 
quick and easy.   

 
Step 1 – Set up the inspection 

   
 
After opening InspectNOW, tap on File  then tap on New, then complete the Inspection Setup 
screens 1 and 2.  It is critical that the Document Type is picked using the Doc Type  pick list. 
Complete the remaining fields.  Doc # can contain both letters and numbers and should be unique.  
If you have created an inspection record in InspectNOW Office you should use the exact same 
Doc #.  The document number appears in the upper right corner of each report page, it serves as 
the unique identifier from one printed report to the next.  Examples of unique document numbers 
are a combination of client name and date (Client Bill Smith inspection on 2/15/07 Doc # 
SM21507) or date and inspection number (Second inspection performed on Feb 15, 2007 Doc # 
21507-2).  Pick a numbering convention that assists you in filing and tracking of reports. 
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Step 2 – View Categories, tap on GROUNDS  
 

                                             
 
Note:  The inspector can pick a rating for each of the steps from the step list window.  This is 
especially helpful if there are steps that are not applicable for the property. Example, if the home is 
slab-on-grade construction with no exterior stairs, simply tap on the black triangle under Rating 
across from Exterior Stairs , the standard rating pick list would appear and tap on N/A for not 
applicable.  Double-tap on Exterior Walls to start entering data. 
 
Step 3 – Double-tap Exterior Walls and Start Entering Data 
 

    
 

Tap on EXTERIOR and the 
Step List: Exterior appears. 

Note the sliding scroll bar on 
the right and bottom.  
Scrolling allows the inspector 
to see the all the content on 
the small PocketPC screens. 

After double-tapping on Exterior Walls the Exterior Wall 
Step Detail window will appear. 
 
Note the four tabs across the top.  Generally it is best to 
start on Materials  and then add comments.  More 
information on the Pict and CC / Info tabs to follow. 
 
Note the + sign after Structure and Wall Covering.  The + 
sign indicates that a pick list will automatically appear 
after selecting one of these material items.    
 
In this case not all the materials are visible on the small 
handheld screen.  To see all materials at once tap on the 

multi-picker button    this will bring up another 
screen (see below) with all the materials visible.  
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Multi-picker window - tap on the 
items to include in the report.   
 
Always tap on items with a + 
sign.   The + sign indicates items 
required by most professional 
standards of practice.  Click OK 
when finished. 
 
Tapping the items also 
determines their order on the 
report.  Each of these items will 
appear as checkbox with the 
applicable text on the report. 

After tapping OK a series of 
windows corresponding to the 
items with the + sign will open. 
 
The user can tap on the pick list 
window (black triangle) and a list 
of options will appear or 
type/write in the information.  
The options in the pick lists can 
be modified in Template Maker.  
Click OK  when complete. 
 
The Cancel button is also 
available if the material step was 
picked in error. 

Next tap the Ratings drop down 
box and choose the appropriate 
rating from the window.  Each 
step must be rated for the 
Category to be complete. 

Next tap on the Comments tab. 
 
Comments serve to further 
elaborate on conditions noted in 
the materials check boxes or to 
comment on conditions not 
available in the materials check 
boxes. 



InspectNOW PocketPC User’s Guide  12 of 25 

      

 

     

 

       

Comments can be added using 
the pick list or by writing/typing 
them in. 
 
Comments are organized by 
headings (Cracks, General, etc.).  
Many comments have label 
located in brackets [  ] to assist in 
their identification.  The 
comment library can be easily 
edited in Template Maker. 
 
Tapping on a comment adds it to 
the report.  Multiple comments 
can be added in series. 

Some comments have embedded 
pick list as indicated with caret 
(“^”).   
 
After picking the initial comment 
a second pick list window will 
open prompting the user to pick 
from a series of options to 
complete the sentence.   If the 
desired option is not in the pick 
list, type or write in the correct 
information.  Pick lists can be 
modified in Template Maker  
 

Multiple comments can be 
chosen, compiling one after the 
other.  Space is automatically 
added between sentences. 
 
There is also a multi-picker 
button on the comments tab.  
When using the multi-picker, 
comments can be picked in any 
order and will compile in the 
order indicated. 
 
See additional information 
regarding comments at the end of 
the guide.  
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Step 4 – Complete All Categories and Steps 
 
After completing the current step move to the next data entry point.  This can be done one of two 
ways:   
  
1.   Tap “OK” at upper right.  This will take the program back to the Step List for the respective 
category.  In this example tapping “OK” will take the user back to Step List Exterior.  From this 
screen the inspector can tap and complete a different step within the Exterior section of the report, 
or tap on the “To Categories” button in the bottom left of the screen to view a list of Categories to 
pick the next data entry category. 
 

2.  Tap the forward arrows   at the bottom right to advance to the next Exterior Step, in this 
example the program would advance to Trim.  Tapping the forward or reverse arrows at the 
bottom of the screen will advance through the steps in a given category but will not advance the 
program to the next category. 
 
Continue to move through the Categories and Steps as you complete the inspection.  In the real 
world of inspecting, the various systems and components do not necessarily present themselves 
for inspection in the same order as they are included in the program.  However this is not a 
problem as it is easy to move between Categories and Steps by quickly tapping the appropriate 
button.  Learning where each step is located, Electrical Wiring, Plumbing Waste Lines, Furnace 
Venting, etc. is critical to easily maneuvering throughout the program. 
 

Creating an Inspection Report 
 
Export the Data File to InspectNOW Office to create the report 
 
In order to print the ITA Matrix Deluxe report it is necessary to transfer the inspection data 
collected with InspectNOW PocketPC to the InspectNOW Office software.  Transferring from 
InspectNOW PocketPC is done in three basic steps:  
 
1) The inspection must be exported from the InspectNOW PocketPC or InspectNOW PC software;  
 
2) The exported inspection must be copied to the “Import/Export” folder on the PC running 
InspectNOW Office;   
 
3) The inspection must be imported from the “Import/Export” folder into the InspectNOW Office 
application.   
 
See the InspectNOW Office User’s Guide for detailed information on exporting inspection data 
and creating a Matrix Deluxe inspection report. 
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Additional Features  
 
Adding Pictures to the Report 
 
There are two ways to add pictures to an inspection and the method to be used is dependent on 
how the pictures are taken.  The most common method is to take pictures with a separate digital 
camera (one not integrated in the PocketPC).  The second is for users that have a camera built into 
their PocketPC device.  Both methods are explained below. 
 
Separate PocketPC and Camera 
 

      
 
Digital camers number each picture.  It is easiest to start each inspection day with either no 
pictures stored in the current folder on the camera or to know what picture number you are starting 
on.  See your camera user’s guide for more information.  Care should be taken when selecting 
picture quality on your camera.  Many digital cameras take pictures at 4 or more megapixels.    
High resolution means large data files which can quickly fill up your computer memory and slow 
down your programs.  For reporting purposes pictures in the 1 to 2 megapixels work best. 
 
Integrated PocketPC and Camera 
 

   

In the Comment window, tap on 
the Pict # button on the bottom 
of the screen to bring up the 
picture window.  Use the + and – 
buttoms to match the picture 
number with the correct number 
in your digital camera. 
 
Once you’ve identified the 
correct number, tap OK.  If you 
change your mind and don’t want 
to reference a picture tap Cancel.  
Tapping Reset brings the counter 
back to 1. 
 
 

If our PocketPC has an integrated camera, 
use the Pict tab located at the top of the 
Materials tab to insert your pictures.  Tap 
on the Pict tab to pull up the picture 
insertion window.   
 
Tap on the Browse button to identify 
where the picture is located in the 
PocketPC.  Then pick the picture.  This 
will tag the picture into the correct position 
within the report. 
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Additional Information about Pictures and Diagrams  
When the “Picture #” button is selected in the Comment tab view a Picture Tag Insertion dialog 
will come up and will default to the next Picture Number. Each time the “Picture #” button is 
selected the Picture Number will be incremented by one.  This number can be changed by 
selecting the “+” or “-“ button.  You can also reset the Picture Number back to “1” by selecting 
the “Reset Counter” button.  Selecting the “OK” button will then insert into the Comment area for 
this Step a Picture Tag. 

 
The Picture Tag will consist of a beginning tag “***” and then the actual picture counter followed 
by the scaling factor. An example would be “***Picture-1;Scaling=100***”.  This is a Picture 
Tag for picture 1 with a scaling of 100%.  You can also change the scaling factor by changing the 
number after the “Scaling=” part of the string.  If you change the scaling value to “200” then the 
picture would print twice the normal size.  If the scaling factor is changed to “50” then the picture 
would print half the normal size.  Resizing the picture applies to printing of the narrative report 
and not the Matrix Deluxe style report.  The pictures are automatically scaled in the Matrix Deluxe 
report. 
 
When the picture tag is inserted into the text area for the current Step it will be replaced with the 
corresponding picture when the inspection is printed.   Notice:  Many digital cameras take 
pictures at 4 or more megapixels.    High resolution means large data files which can quickly 
fill up your computer memory and slow down your programs.  High resoluction is useful 
when reprinting photos in large formats but not necessary for pictures that appear in an 
inspection report.  For reporting purposes pictures in the 1 to 2 megapixels work best. 

Diagrams – Diagrams can be automatically included in the printed report also.  By using 
TemplateMaker you can associate any material or comment with a diagram. When this material or 
comment is selected during the inspection process the associated diagram’s pathname is inserted 
into the comment area for that Step.  When the narrative inspection report is printed the associated 
material is then printed alongside the material or comment it is associated with. Below is an 
example of a Material “[Knob and Tube]*” associated with a diagram “0049.JPG”. 

In the example above, the diagram tag “***Path=C:\Diagrams\0049.JPG;Scaling=100***” 
contains the pathname to the diagram. When the inspection is printed the diagram tag will be used 
to find the associated diagram while printing and will be included during the printing process. If 
the printing of the inspection is done on a handheld type of device (narrative reports only) then the 
diagrams need to be present on a type of media that can be inserted into the handheld.  Many of 
the possible storage media devices range from a CF (CompactFlash) card, SD (Secure Digital) 
card or Multi Media card.  If the diagrams are on a PC or CD then copy the diagrams needed onto 
this media.  You will also need to enter the volume pathname in the Options field “Default Pict 
Path”. This field represents the name of the storage media that the diagrams are on.  The pathname 
for the Diagrams uses this field to change the pathname to gain access to the diagrams when 
printing. 

 
Additional Information about Comments. 
 
Fill-in-the-Blank Comments – Some comments may contain an insertion caret ("^").  When a 
comment containing this caret is picked, the user will be prompted to supply information to “fill-
in-the-blank” for that comment.   
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Pick list comments – InspectNOW comes with a robust comment library. Each step has numerous 
comments.  The first comment (displays in brackets [1] ) in each step is an “Appears Serviceable” 
comment.  While it is not necessary to state the step is in serviceable condition if the Appears 
Serviceable rating has been picked, some inspectors want to be able to restate the serviceable 
condition.  The second comment bracketed as [2] is a comment that states further evaluation and 
repairs are recommended.  Again this option is also available in the step rating.  Additional 
comments appear organized by topic.  Many of the comments have labels that appear in brackets 
to help the user identify the comment without having to read the entire comment.  See information 
on Comment Labels below.  Comments can be edited in Template Maker or on the PocketPC.  See 
additional information below. 

Adding a comment on the fly - If the comment you need is not already in the list, simply write or 
type it into the comment entry area.  To add a comment to the pick list of comments, just tap the 
“Add” comment button.  The comment will now be available in the list for future inspections.  
(Note – To edit or delete comments from the list you must use Template Maker on the PC and 
download the changes to your handheld device.  You cannot edit or delete comments from the 
pick lists themselves.)  Refer to the Template Maker User’s Guide for more details. 

Pick List items - You can also have another pick list inside embedded within your comments.  An 
example could be "Limited review due to ^pReview^." where the "pReview" List item has the 
following list items (“snow”, “junk”, “boxes”, “furniture” etc. .  This makes it possible to pick one 
of these choices to fill in the blank instead of writing or typing it in.  This is a powerful feature, 
allowing the inspector to customize the comment options to their inspection style and geography. 
 
Comment Labels - You can begin a comment with a label that helps designate the content of the 
comment when it is selected.  Example the label [major] for a comment in the “CRACKS” group 
of comments would indicate that the comment was about major cracks visible at time of 
inspection.  Labels can also be used to determine the order or groupings of comments. In 
InspectNOW the first comments in every comment library are designated by a [1] Appears 
Serviceable and a [2] for Recommend further evaluation and repairs. 

Viewing Comments Only - Once you have completed your inspection the Inspection software 
lets you review your selected comments with your client by using the "Review Comments" 
window.  To view a list of all of the comments entered for the current inspection select "Review 
Comments" from the "View" menu.  A scrollable list of comments will appear.  To view or edit 
any comment from the list, simply double -tap that comment. When you have finished with the 
comment tap the “OK” button to return to the comment list. 
 
The View Rating drop down list will list all of the ratings you are using when you select the down 
arrow. Selecting one of the Ratings will narrow down the Comment list to just the one selected.  
Selecting the “Summary Comments Only” checkbox will narrow the list of Comments to the ones 
only rated that would appear on the Summary report. 
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Additional Information about the CC/ Info Tab  
 
The "Info" tab in the Step Detail window is another power feature of InspectNOW.  These tabs 
come preloaded with much of the information included in Code Check® 4th Edition.  The 
information appears in the respective Steps, thus electrical wiring info is found on the CC / Info 
tab in the Electrical Wiring Step, Heating Ventilation in the Heating Ventilation step etc.   
 
None of the data present in the "Info" tab appears in the report, it is for reference only.  Any Step 
that has reference material like this will have the CC / Info tab in the Step List Window.  Tapping 
on this tab brings up the respective information.  Additional information can be added to this 
section valuable tool by the inspector using Template Maker.  See Template Maker User’s Guide 
for more information. 
 
Deleting an inspection 
 
To delete an inspection from the Inspector application you go to the Inspection List view and 
select the inspection you want to delete.  Then select "Delete Inspection" from within the "File" 
menu. A Confirm dialog comes up that shows the properties of the inspection you are about to 
delete. Tap the "Yes" button to confirm the deletion. A progress bar will appear as the inspection 
is being deleted. This can sometimes take a few minutes to complete.  Please wait until the delete 
is completed.  Do NOT reset the handheld device while the deletion is being done. 

 
There is also a Delete All Inspections function.  This could be used after the inspections have been 
exported as an RTF file. This makes it easier to delete the inspections all at once and keep the 
number of inspections on a handheld at a minimum number.  Important Notice:  Make sure to 
back up inspection data and reports before deleting inspection report data.  All data should 
be backed up regularly.  If you make modifications to the report in InspectNOW Office 
before generating the Matrix Report, the report will differ from the inspection data initially 
exported from the handheld.  For this reason, it is  recommended that all inspection reports 
be backed up and archived by the inspector.  See Back Up to a PC at the end of this guide 
for more information. 
 
Duplicating an inspection / Creating a Template Inspection  
 
To duplicate an inspection from within InspectNOW Inspector application you go to the 
Inspection List view and select the inspection you want to duplicate.  You then tap the "Duplicate 
Inspection…" button. When the Duplicate Inspection dialog comes up (Diagram 1.19) then enter a 
new document number for the newly duplicated inspection.  This way you will be able to 
distinguish it from the original.  Tap the OK button and the currently selected inspection will be 
duplicated along with all of its Categories, Steps, Ratings, Materials and Comments.  This is a 
good way of creating a generic inspection template and then using it as a base inspection to start 
from.  This can help shorten the inspection process on site.   
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WARNING: Using the Duplicate Inspection feature can also make it easier to make mistakes 
and forget to change previous set defaults.  Use this feature very cautiously. 
 
Diagram 1.19 - Duplicate Inspection Dialog 

 
 

Using Expanded Text  
 
InspectNOW has the ability to use a type of short-hand called Expanded Text.  This feature can be 
used in any of the Comment text entry areas.  The inspector either types or writes in the short-hand 
code followed by the “@” symbol.  InspectNOW then automatically expands the short-hand code 
into its associated text.  An example of this feature could be an Expanded Text code of “rr” that 
could expand to the following text: “Recommend further evaluation and repairs by a qualified 
professional.”   Expanded text can be of any length from one word to an entire paragraph.  There 
is a “@” button on the Comment text entry area also to make it easier to use the Expanded Text 
feature. 
 
InspectNOW comes with the following three expanded text comments: 
 
rr = Recommend further evaluation and repairs by a qualified professional. 
rs = Recommend further evaluation by a structural or geotechnical engineer. 
ss = Appears Serviceable   
 
Additional comments, or editing of the above comments can be done using Templa te Maker.  See 
Template Maker User’s Guide for additional information 
 
General Comments   
 
You can also have comments that are particular to an inspection that you want to show at the 
beginning of your report or the beginning of a Category .  This is a general comment or disclaimer 
that pertains either the entire report if placed at the front or the specific category if placed in the 
category.  In the Matrix Deluxe report we use this function to place the categorical disclaimers.  In 
the Narrative report a comment could be placed at the beginning to apply to the entire report.  To 
enter this comment area, tap the Comment Icon button on the taskbar at the bottom of the screen 
when you are inside the respective category or at on the inspection set up screen if you intend to 
have the comment precede the narrative report.   
 
(See screen shot next page) 
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Printing a Narrative Report or Report Summary 

Important Notice:  To print the Matrix Deluxe style report you must export the data file to 
InspectNOW Office and open the file in InspectNOW.  InspectNOW is the program that 
creates the Matrix Deluxe style report.  See the InspectNOW Office User’s Guide for 
detailed information on exporting / importing the data file, and creating the Matrix Deluxe 
style report. 

To Create a Narrative Report / Print A Summary from the PocketPC 

Go to the “View Menu” and tap “Inspection List”.  To print a report take the following steps:  
Select or open the inspection you wish to print.  (Note – single tap selects the inspection, a double -
tap opens the inspection.) 

Once you have selected (or opened) the inspection you wish to print, go to the “File” Menu and 
tap “Print…” A "Print Properties" dialog will appear (Diagram 1.13) giving you the Print Report 
options.   
 
Diagram 1.13 - Print Properties dialog 

 

Comment Icon 
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Inspection Report -By default, you can print the full inspection report.  Selecting the "Print 
Inspection" radio button will print out the entire inspection with all the data you collected for the 
current inspection.  A page break is inserted after every Category when you print the report.  This 
makes it much easier to reprint a single Category when changes are made without having to reprint 
the entire report.  

Continuous option - If the "Continuous" check box is checked this suppresses the page break 
after every Category in the inspection report.  Each new Category and its associated Steps are 
printed after the previous Category in a continuous report that makes the report shorter and a little 
quicker to print.  The disadvantage of printing the continuous report is when you need to reprint a 
specific Category you will need to reprint all the Categories after the correction in the report.  If 
each Category has a page break you only need to reprint that one Category again. 

Print Summary – Select the “Print Summary” radio button to print just the Inspection Summary 
Report.  This is a condensed report that only prints out the Steps and Comments that were flagged 
as significant and should appear on the Summary.  This is controlled by the rating choice that is 
selected for each Step.  An example could be a rating choice called "Repairs Recommended" that 
would force the Step and any Comments for that Step to print on the Summary report.   
Controlling which rating choice has the Summary flag set is set in TemplateMaker. (Refer to the 
Template Maker User’s Guide for more information) 
 
Page Selection – To print specific pages select the “Pages” instead of “All” and then fill in the 
“From” field and then the “To” field.  If you needed to print page 9 over again you would select 
the “Pages From” radio button and then put the number “9” into the “From” and “To” fields.  
(Note: If you change the “Starting Page #” field then make sure to change the “From” and “To” fields 
appropriately.) 
 
Starting Page # - If there are other preprinted pages you need to include in your report before the 
inspection report you can change the beginning starting page number that is printed from the 
InspectNOW software.  If you want to include a 2 page legal contract at the beginning of the 
report, before the regular categories, then the Starting Page # would be changed to 3. 
 
Number of Copies – Use this field to print multiple copies of the report you are printing.  You 
can use it for the full inspection report or the Summary report. 
 
Print Dialog 

Once you have selected the type of report you want to print and the print options in the Print 
Report dialog and have tapped the OK button the standard Windows print dialog (Diagram 1.14) 
will appear as shown below. 
 
Diagram 1.14 - Print Dialog 
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Select the appropriate printer you are printing to in the "Printer" drop down list (some examples 
are the "HP PCL3 Compatible" for the HP 340 and the "Canon BJC" for the Canon BJC-80 
printer) and then select the "Port" type you are using to print from.  Some of the options that are 
available in the "Port" menu item are “USB”, "Irda", COM1, and JETCONNECT.  There is also a 
"Print Preview" option then you can select in the "Printer" drop down list to preview the reports on 
the handheld before actually printing the report. 
Checking the "Draft Mode" checkbox in the "Print" dialog can significantly increase the speed of 
printing the reports. 
 
Tapping the "OK" button on the "Print" dialog brings up the last dialog that has other options that 
are dependent on what Printer driver you selected in the previous "Print" dialog.  To get more 
information on the specific options and settings available in the JETCET PRINT dialog (Diagram 
1.15) tap the help (?) button in the dialog. 
 

Merging partial inspections 
 
Sometimes during big inspections it would be beneficial to be able to have more then one 
inspector at the inspection site. InspectNOW can merge partial inspections together from multiple 
inspectors to create a final inspection.  There is no limit to the number of partial inspections that 
can be merged.  The inspection job can even be broken up within a single category.  This means 
that one inspector could be inspecting the appliances in the Kitchen category while another 
inspector is inspecting the electrical outlets.  When the merge process occurs the software will 
successfully merge the separate steps within the Kitchen category appropriately.   
 
To start the merge process you must decide who will have the final completed inspection. The 
other inspectors will then need to select their partial inspection they have completed and then 
select the “Export Inspection” menu item from the “Export” menu.   
 

 
 
The “Save As” dialog (Diagram 1-20) will come up where you will browse the Folder window 
identify where you want to save the partial inspection file.  Name the partial inspection what you 
want in the “Name:” field and select the “Save” button.   
Diagram 1.20 – Save As dialog 
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Once you have exported the partial inspections from the other inspectors you will need to get these 
exported files to the master device where the final inspection will be completed from.  This can be 
accomplished by either copying the file to an external media device like a CF card, SD card or you 
can transfer the file from your PocketPC to your PC using ActiveSynch.  This is a simple copy and 
paste function. 
 
Once the partial file(s) are transferred to the computer or device that the final inspection will be 
created on you will then launch the inspector app that contains the final inspection and select the 
“Import Inspection” from the “Export” menu. 
 

 
 
 
From the “Open” dialog (Diagram 1-21) select the partial inspections you have exported from the 
list and select the “Open” button. This will add this inspection to the list of imported inspections in 
the inspection database. You can select as many as you want if there were more then one inspector 
that completed parts of the full inspection.  You can import these partial inspections at any time.  
The inspector in charge of the final inspection could be half way through their portion of the 
inspection and import the partial inspections of the other files and then complete their portion and 
merge all of the data together at a later time. 
 
Diagram 1.21 – “Open” dialog 

 
 
Once the partial inspection files are imported and you are ready to merge all the data together you 
select the master inspection you want to merge into from the Inspection List view in InspectNOW.  
Once the inspection is highlighted you select the “Merge Inspection…” button.  In the example 
below (Diagram 1-23 & 1-24) we are selecting the inspection for Joe Smith and merging in the 
partial inspections with the inspection numbers of 1316 and 1317. Once the partial inspection 
documents are merged in you will be able to see all the inspection data in the original inspection 
plus all the partial inspection data merged into it also. 
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Remember inspections can be merged across handhelds of the same type or even across a CE 
tablet and a PocketPC.  Some inspectors will also use the merge feature to do a partial inspection 
on a handheld and then export it and merge it into the original inspection on the PC version of 
inspector.   
 
Diagram 1.22 - Sample of merging inspections 

 
 
Diagram 1.23 – Merge Inspection List dialog 

 
 



InspectNOW PocketPC User’s Guide  24 of 25 

Backing Up to a PC 
As with all computer systems, it is important to back up your critical data on a regular basis.  
Borealis recommends daily backups of your inspection data. 

Please refer to the documentation that shipped with your hardware for general backup instructions 
for your handheld device.  Microsoft ActiveSynch (a program that runs on your PC and 
communicates with your connected handheld device) provides an easy means for backing up to the 
PC. You will find the “Backup/Restore” menu item in the Tools menu.  

Perhaps the simplest way to backup inspection data is to use the “Export RTF…” feature from the 
file menu and transfer the corresponding document to your PC.  This is a standard process when 
creating the Matrix Deluxe style report.  The data files for all such reports must be exported from 
the PocketPC or PC application into InspectNOW Office to format the report.  Changes made to 
the report in InspectNOW Office will not be reflected in the original inspection data file on the 
PocketPC or PC.  It is important to back up the InspectNOW reports regularly, we recommend 
daily. 

It is recommended that you back up your critical PC Data to some type of removable media such 
as a CD, flash drive, media card or external hard drive.  Unfortunately computers are subject to 
damage and failure, in such situations it may be impossible to recover your inspection data if you 
do not back it up as recommended.  Check with your local computer hardware retailer for 
additional information on back up options. 
 
 
Backing Up to a CF or PCMCIA card 

Another easy way to backup and restore your handheld data is to use a Compact Flash(CF) card or 
SD (Secure Digital) card.  These memory cards come in many sizes from 128MB multiple 
gigabytes.  Reference the associated manuals for more information on how to backup and restore 
using these cards and the 3rd party backup applications that come with each handheld. 
 

Technical Support 
 
InspectNOW is created by Borealis Communications, LLC for Kaplan Professional Schools – 
Inspection Training Associates.  Contact Borealis directly for technical support.  Upon initial 
purchase InspectNOW comes with unlimited support for 30 days.  Additional support can be 
purchased in one year increments. 
 
Borealis contact information: 
 
Phone:  715-381-1633 
Email:  support@borealisweb.com 
Web: www.borealisweb.com 
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Definitions of Terms 
 
Back up – refers to saving data files, inspection reports, etc. to a secondary location, preferable 
outside the computer or handheld device.  Back up files are used in emergencies if the primary 
system is damaged or corrupted.  In today’s world of computer viruses, it’s imperative that 
inspection data is backed up regularly. 
 
Category – a major component of a residential property Example: Electrical.  A category is the 
highest level of data organization in InspectNOW.  Data collection is organized by Category, then 
Steps, then Ratings, Materials and Comments. 
 
CC / Info – a tab that appears at the step window providing the user with access to Code Check® 
4th edition and other supporting information. 
 
Comments – narrative information provided to clarify conditions that exist at the time of 
inspection. 
 
Comment Library – InspectNOW comes with a robust collection of preformatted comments that 
can be inserted in the comment sections throughout the report.  The comment library can be edited 
in Template Maker.  Comments can also be typed in or written in using the PocketPC writing 
recognition program.  See the user’s guide that came with the PocketPC device form more 
information.    
 
Dialog – refers to a window that opens on the PocketPC.  The window can be filled with a various 
information, choices and additional options. 
 
Doc # - a unique number given to each inspection.  Document numbers appear in the upper right 
corner of the Matrix Deluxe reports and on the inspection contract.  Document numbers should be 
unique for each inspection, often inspectors use a combination of the clients name and the date. 
 
Edit – to modify existing text or in the case of a pick list or comment to add additional 
information. 
 
Expanded Text – a “short-hand” of sorts allowing the user to enter only a few characters followed 
by the @ sign from which the program will insert an entire sentence or paragraph. 
 
Pick List – a list of options that can be picked by taping the desired option on the screen.  Pick 
lists are crated in Template Maker and are used to “fill in the blank” within various locations and 
comments in the comment library. 
 
PocketPC – a handheld device used to collection inspection information out in the field.  It is the 
portable data collection hardware on which InspectNOW for PocketPC is installed. 
 
Material – a third level of data organization used to identify conditions that exist at the time of 
inspection, location of specific items, or the actual material that something is made of. 
 
Ratings – short comment used to identify if a system appears serviceable or needs additional 
evaluation and/or repairs. 
 
 


